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Welcome

Welcome to the world of Xeltek SuperPro programmers. Xeltek has produced the
SuperPro line of IC programmers since 1985. Our motto is to provide high value
products at affordable prices. In the past 23 years, Xeltek has produced a string
of highly popular and successful programmers including SuperPro, SuperPro II,
SuperPro III, SuperPro V, SuperPro 680, SuperPro 8000, SuperPro 3000U, and
SuperPro 9000 models.

SuperPro 3000U is the first model to incorporate both PC connected and
stand-alone modes operations combined into one programmer. It is also the first
programmer to break the barrier of 40,000 devices supported in the industry.
SuperPro 3000U is by far the most popular IC programmer in the industry today.

Pushing the barrier further yet, Xeltek is proud to announce the family of
SuperPro 5000 programmers. SuperPro 5000 retains all the good features of
SuperPro 3000U, but, in addition, it is designed to program today’s large size
devices efficiently and effectively.

Feature Highlights

1 The SUPERPRO includes ultra high speed programming via 32bit RISC MCU
device. This is especially suitable for programming high capacity NAND Flash
devices

1 A 144 pin-driver support is built-in to provide efficient programming of
large pin count devices, an additional pin expander module is not necessary
to program large pin-count devices.

] The SUPERPRO operates with a PC for engineering purpose or in stand-alone
mode, without a PC, for repeat production mode programming. This provides
seamless migration from engineering to production

1 The SUPERPRO communicates through a USB 2.0 port and operates on most
Pentium-based, IBM compatible desktop/notebook computers.

] The SUPERPRO comes with a standard 48-pin DIP ZIF socket and supports
optional socket adapters to accommodate PLCC, TSOP, SOIC, SOP, QFP,
TSSOP and BGA package types.

] The programmer and software supports Windows XP and Windows Vista.

(1 The programmer is scheduled to support 43,000+ IC devices by the end of 2008.
Please check www .xeltek.com for the list of the currently supported devices.

Superpro®5000 User’s Guide 8



1 For authorized users, the SUPERPRO can provide for automatic generation of
electronic serial numbers.

IMPORTANT! Make sure to complete the software installation before connecting
the programmer USB cable.

User Manual Organization
This manual includes the following:

] An introduction to the SUPERPRO series, including the system requirements
and the software and hardware installation

] Detailed explanations on the commands and the programming procedures
] Information about error messages and common problems
] An Appendix that includes the customer support information

Note: The software prevails in any discrepancy between it and the user manual,
due to any upgrades of the software.

The information in this document is subject to change without notice.
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Chapter 1 General Description

This chapter provides information on the package contents, software features,
and system requirements for SUPERPRO.

Introduction to SUPERPRO

The SUPERPRO is a menu-driven software that operates a series of cost-effective,
reliable, and high-speed universal programmers. SUPERPRO communicates
through a USB 2.0 port and operates with most IBM-compatible desktop and
notebook computers based on Pentium.

Package Contents
The SUPERPRO programming hardware includes the following items:

[l A programming module (including a 48-pin ZIF socket) (SuperPro 5000/5000E
come with a removable DIP48, CX0001 adapter, while SuperPro 500P/501S
come with an attached DIP48 socket.)

1 A power supply unit

1 A USB connection cable

The SUPERPRO package also includes a software installation CD, this User’s
Guide and a registration form.

Optional socket adapters to accommodate PLCC, TSOP, SOIC, SOP, QFP, TSSOP
and BGA package types are available.

Software Features
The USB 2.0 Series supports:
1 Windows XP and Windows Vista

(1 Over 25,000 (40,000 + by end of 2008) types of devices, including
PROM, E/EPROM, PLD and MCU from more than 150 manufacturers

1 Many types of formats such as Binary, Intel (linear & segmented) Hex,
Motorola S, Tektronix (linear & segmented), JEDEC, POF, etc.

SUPERPRO also includes a device insertion test (48 pins or less) to detect defective
chips, improperly inserted devices and pins of poor contact (model dependent).

SUPERPRO includes an integrated full screen buffer editing environment with
commands such as fill, copy, move, swap, etc. It automatically generates electronic
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serial numbers. Authorized users can use a user-defined mode.
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System Requirements

The minimum system configuration is as follows:

1 A desktop or laptop computer with Intel Pentium or an equivalent processor

1 Windows XP or Windows Vista operating system

] Atleast 1 GB free space on the hard drive

[J At least one standard (USB 2.0) compliant connector
1 A CDdrive

Superpro®5000 User’s Guide
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Chapter 2 System Installation

This chapter provides information on how to install the software and connect the
programmer hardware properly.

To avoid complications during the installation process, you must install the
software before connecting the programming hardware to your computer.
Installing the software sets up the INF files and drivers automatically instead of
going through the Windows New Hardware Wizard. This might install the
wrong drivers with a compatible ID.

Software Setup

Select the software to setup your SUPERPRO programmer either from the
CD-ROM or by downloading the program from the Xeltek website. Instructions
for both methods are described below.

CD-ROM

1. Insert the CD into the CD-ROM drive.

2. If the setup program does not start automatically, run SETUP. EXE located in
the root directory.

The system displays a dialog box to select the programmer model, illustrated

below.

Type of Programmer: Yersion:

SUPERPRO 5000 f* Winclow
SUPERPRO 5004

SUPERPRO 3000058012800
SUPERPRO 9000U
SUPERPROJGED
SUPERPROISE0 Products;
SUPERPROV250 v
SUPERPRO/S000 {* Programmer
SUPERPROV2000+
SUPERPROM 000
SUPERPROMN
SUPERPROH" ...............................
SUPERPROF © Setup
suPERPROLNLY b
SUPERPROVZ

" Dos

" Emulator

Cancel

3. Select the appropriate programmer model. Make sure to select the model you
purchased, since each model has its own software.

Superpro®5000 User’s Guide 13



4. Select Setup to install the application software for the programmer.

Xeltek Website

You can download the specific software for a certain model at Xeltek website:
http://www xeltek.com. Select the icon to download the appropriate file for your
programmer. Once you have saved the file to your computer, run it to setup the
software.

Setup Process (for SuperPro 5000)

The following procedure explains the setup process.

1. The system displays the Select Language dialog box, illustrated below.

@

Select Language @1

7] Flease select a language during
installation

English v

Select your preferred language for the setup process from the drop down list.

2. Select OK.

Superpro®5000 User’s Guide 14



The system displays the Install Wizard dialog box, illustrated below.

Install ¥Wizard

Preparing to Install...

Setup is preparing the Install Wizard, which will
guid you through the setup process.
FPlease wait.

unpacking data...

(T D)

This Wizard will zuid you through the steps required
to install Programmer Control Software on your
computer .

It's strongly recommended that wou exit all other
windows programs before running this setup program.

WARKNING: This program is protected by copyrigtht law
and international treaties.

Click Next to continue, or Cancel to exit Installation

[ Hext ] | canca |

3. Select Next to proceed to the next step.
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The system displays the License Agreement, illustrated below.

{# SUPERPRO 5000/5000E, Version 1.0 X

License Agreement 6
Please review the following License terms carefully. |
a W .

IMFORTANT: FLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY A
BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU ARE

AGREEIHNG TO BE BOUND EY THE TEEMS AND CORDITIONS STATED BELOW IF —
YOU DO HOT AGREE WITH THE TERMS OF THIS LICENSE, FROMPTLY RETURN
THE UNUSED SOFTYARE TO THE POINT OF FURCHASE AND YOUR MONEY WILL

EE REFUNDED.

1. License.

Xeltek grants to the Licensee purchasing this copy of SUPERFPRO
For Windows Software a nonexclusive, nontransferable license to
use the software and other software and fonts contained in this
package (collectively the "Software”) and its documentation for

A
< >
If you accept the license agreement, click I Agree to continue You
must accept the agreement to install the Control Software.
[ { Back ] l; I Agree :I [ Cancel ]

4. Please read the license agreement carefully. Select I Agree to continue the
installation. To cancel the installation and exit the installation process, select
Cancel.

The system asks for the Destination Location, illustrated below.

i SUPERPRO 5000/5000E, Version 1.0 @

Select Destination Location

Where should the software be installed?

To contimue, click Next. To install to a different folder, click
Browse and select another folder.

Destination Fold

C: %SP5000 | [Browse ..

Space required ; 111.8 MEB

l < Back ] | I Agree | [ Cancel ]

5. Select Browse to choose the installation path. After selecting the
desired destination folder, select Next.
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The system displays the Additional tasks dialog box, illustrated below.

{& SUPERPRO 5000/5000E, Version 1.0 X
Select Additional tasks e
‘Which additional tasks should be performed? ‘ >~ \

Select the additional tasks you would like Install Wizard to
perform while installing.

[V]Create a start menu icen

[V]Create a desktop icon

[ < Back I l: Hext > l| [ Cancel l

6. Check the Create a start menu icon box to add an icon on the Start menu

during the installation. Check the Create a desktop icon box to add an icon to
the desktop during the installation. Select Next.

The system displays the following dialog box.

Ready to Install the Program

the “Wizard is ready to begin installation. | 1

N

If you want to review or change any of your installation settings, click Back Click
Cancel to exit the Wizard.

Current settings:

Destination Folder:
C:%SPS000
Start Menu Folder:
SUPERFRO USBZ.0 series
Create a desktop:

SUPERFPRO USBZ.0 series

[ < Back ] l Install x| [ Cancel ]

7. Review the settings you selected. Select Install to proceed to the next
step. Select Back to return to a previous step to change your selections.
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The system displays the following dialog box.

i SUPERPRO 5000/5000E, Version 1.0 3
Setup is installing 6

Please wait while Setup installs. This may take several minutes.
P J N

& < &

Extracting files...

C:\SPS000%bin'ManuList. d11

(I 1

The system copies the files, installs the drivers and registers the software.

If you are using Windows Vista, the system displays following dialog box.

4 Windows Security

@ Windows can't verify the publisher of this driver software

< Don't install this driver software
You should check your manufacturer's website for updated driver software
for your device,

* Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

(v) See details

8. Select Install this driver software anyway.
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The system displays the following dialog box.

{2 SUPERPRO 5000/5000E, Version 1.0 3

Install Wizard Completed

The Install Wizard has successfully installed the

software Click Finish to exit the wizard.

[¥]Lannch the program

9. Select Finish to complete the setup process.

Hardware and Driver Installation

If you connect the hardware before installing the software, the system opens the
Found New Hardware Wizard, illustrated below.

Found New Hardware Wizard

This wizard helps you install software for:

USE Device

1 .'4_)‘ If your hardware came with an installation CD
~i=” or floppy disk. insert it now.

Wwhat do you want the wizard to do?

() Install the software automatically [Recommended)
) Install from a list or specific location (Advanced)

Click Mext to continue.

[ < Back ][ Mest > ]I Cancel I

1. Select Cancel to make sure the system does not install the wrong driver.

2. Return to the Software Setup process to setup the software before installing the
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hardware. Refer to page 13 for instructions.

After you set up the software, you can install the hardware and driver.
The following procedure explains the installation process.

1. Make sure all other programs are closed during the installation process.
2. Connect the programmer module to the computer through the USB port.
3. Turn on the power switch of the programmer module.

When you connect the new hardware, the system initiates the New Hardware
Wizard, which locates the driver from the software you have just installed. The
system displays alerts one at a time, illustrated below. The alerts on your system
may be slightly different.

i) Found New Hardware
USE Device

i) Found New Hardware

USBZ.0 programmer

F: ™
j,! Found New Hardware X

Your new hardware is installed and ready to use.

4. After you open the application software for the programmer, the system
automatically starts the initialization. If it does not, make sure the programmer is
securely connected to the computer and that the power switch is on.
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Chapter 3 SUPERPRO Software Features

This chapter gives detailed explanations of the software functions of the
programmer.

Main Screen

The main SUPERPRO screen is illustrated below. Each part of the user interface is
labeled with a number and described below.

SP5000 — SUPERPRO for ¥Windows @@@

File Buffer Device Option Project Help

SEFREED

ATMEL ATS89CS1 FLASH1000H*S 40Pins v
Checksum: 000FFO00OH  File = v
Operation Option Edit Auto Dev, Config Dev. Info Data Compare
= Cnutn | e ———-——-—— SUPERPRO programmer Starts —-—————————————————-
o Current time is 6/20/2008,13:43:31.
*J Progran Preparing...
. Checksum: OO0OFFOOOH
"< Read Ready.
14 Verify
’¢ Blank_check
4 Erase
*J Lock Bit1
*J Lock_Bit12
: LDI:I(_Bit123
Success: | O Count down: Disabled
Failure: [0 Count Total: | O
Total: E ] Remains: E ]
Reset Count Down

lReady CANCE

1. The Main Menu provides access to the File, Buffer, Device, Option, Project, and
Help menus. Refer to the Menu section beginning on page 22 for more
information.

2. The Toolbar includes icons for quick access to common functions. Refer to
Tool Bar section on page 49 for more information.

3. Select Device to open the Device Selection dialog box. Refer to Select Device
on page 33 for more information.

4. Select Buffer to open the Buffer Edit window. Refer to Buffer Menu on page 26
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for more information.

5. The system displays information about the selected device. Refer to Main
Screen Device Information Display on page 51 for more information.

6. The system displays information about the file currently loaded in the buffer.
Refer to Main Screen File Information on page 52 for more information.

7. The Operation Option toolbar facilitates setting the operation options properly.
The items correspond to the items in the Option Menu. Refer to the Option
Menu section beginning on page 39 for more information.

8. The left side of the screen lists device operation functions. Refer to the Device
Operation Window section on page 55 for more information.

9. The Operation Message Window displays the operation process, the
operation result and the historical records of information. Refer to the
Operation Information Window section on page 59 for more information.

10. The Status bar displays the menu item info, the progress of operation, and a
Cancel button. Refer to the Status Bar section on page 59 for more information.

11. The Statistical Window displays statistical information. Refer to the section on
page 60 for more information.

Main Menu

File Menu

The File menu provides access to the Load, Save, Recent Projects, and Exit
functions. Each function is described in the following sections.

Load File

There may be one or more data buffers in the device. If several data buffers are
displayed after you have selected the device, refer to the name and the data
manual for the meanings of the buffers.

The two data types of the device are Data (HEX/ASCII) and Fuse.
1 For most EPROM and SCM, the data type is Data (HEX/ASCII).
1 The data type for PLD device is Fuse.

After you select the device, the software automatically identifies the data buffer
type. You can review the buffer data types if you open the Edit dialog box for the
data buffer. Refer to the Buffer Menu on page 26 for more information.
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When some file data are loaded into the data buffer, the following rules apply:

11 With a HEX/ASCII data buffer (EPROM, MCU etc.), the system assumes that 8
bits of the data are valid.

1 With a JEDEC butffer (PLD/PAL), the system considers the lowest bit (1 bit) of
the file data valid.

Select Load from the File menu to open the Load File dialog box, illustrated below.
The red labels refer to the numbered explanations below.

Buffer: v 1
File Name: 2 ﬂ]
File Type: 2
File Mode:
Buffer Address: |/ K
File Address: 6—
Q Show Offset Address(Minimize) afte
[ OK ] [ Cancel ]

1. Select the data Buffer name from the drop down list, as illustrated below.

Buffer: /Flash \\. v
Flash

File Mame: = ‘ | Browse

[ The default option is considered the programming zone of the device as
described in the data manual.

[ To choose between several buffers, determine the corresponding
programming zones according to the names and the data manual.

The system loads the file data into the data buffers according to the data buffer
names.
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2. Enter the name of the data file to load in the File Name field.

Alternatively, you can select Browse and choose the file using the Select File
box, which is illustrated below.

Select File
Look in: | L3 bin v O ¥ [E
| = deindex =h loader_ RSPSUEU 9 xeusbwSk
4] DigEse. dll =) log 2 spLime ] xostrcls.di
] GETDATE S)Manutist.dl  FEPUninstal
Hnit_Lan g =) w_ELTEK usb

g irétbin %] sockClient.di @ xelbek.id

= loader S sockServe.dl | xeushS

Files of type: | AR fief™.") v Cancel

File name o ‘
[_Concel |

HEX(" hex)
Motorola 5-Record(” %)
Binary” bin) -

First select the file type from the Files of type drop down list.

11 Data (HEX/ASCII data) file types can be further divided into many different
types according to their storage forms. You must select the appropriate file
type to ensure the data loads correctly.

[ The file type for Fuse data files is JEDEC and the file extension is “jed.”
After selecting the file, you do not need to select the data file type.

Altera Corporation uses POF format files. To program an Altera Corporation chip,
refer to POF Format Files on page 77.

3. Select the File Type from the drop down list.
4. Select one of the following File Modes from the drop down list:
1 Normal to load the whole file

T Even to load the first byte and discard the second byte out of every two
bytes

77 Odd to discard the first byte and load the second byte out of every
two bytes

7] 1st byte of 4 to load first byte and discard the other three bytes out of
every four bytes
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] 2nd byte of 4 to load the second byte and discard the other three bytes out
of every four bytes

] 3rd byte of 4 to load the third byte and discard the other three bytes out of
every four bytes

[l 4th byte of 4 to load the fourth byte and discard the other three bytes out of
every four bytes

1 1st2_byte of 4 to load the first two bytes and discard the other two bytes
out of every four bytes

I 2nd 2_byte of 4 to load the last two bytes and discard the other two bytes
out of every four bytes

Refer to Separate File Data for Programming on page 77 for more information.

5. The Buffer Address field displays the start address of the data loaded into the
buffer.

6. The system displays the minimum offset address in the File Address field. If
the file type has a non-zero start address, enter the data offset address in the
File Address field. Make sure to enter the correct address, because an incorrect
file offset address causes part of the buffer to be filled with FF (or incorrect
data). This causes a system overflow or failure. Refer to Solve Invalid File Type
or File Data Overflow on page 77 for more information on this problem.

7. Select the Buffer clear on data load with checkbox to fill the data buffers with
the specified data.

8. Enter the data input type.

9. Check the Show Offset Address (Minimize) After Loading to show the
minimized file offset address or initial address on the screen.

10. Select OK to load the file. Otherwise, select Cancel.

Save

Select Save from the File menu to save data in the current buffer to a disk file. The
system opens the Save File dialog box, illustrated below. The red labels refer to
the numbered explanations below.
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Buffer: Flash 1 w
File Mame: 2
File Type: Binary 3 v
Buffer Address: |0 4
Save Data Size: | 1000 h
[ [8]4 I [ Cancel ]

Select the Data Buffer Name from the Buffer drop down list.
Enter File Name for Data or select Browse to select a file name.

Select the type of file from the File Type drop down list.

=L

Enter the start address of the data buffer in the Buffer Address field. The saved
data starts at the start address.

5. Enter the save data size in number of bytes in the Save Data Size field.

Recent Projects

The File menu lists the full file names, including the full path, of any
recent projects. Refer to the Project menu for a definition of the project.
Exit

Select Exit to close the programmer software.

Buffer Menu

The process of programming a chip is the process in which the system writes
buffer data into the chip storage units according to the manufacturer’s
requirements. The Buffer menu manages data in the buffer. Each option is
described in the following sections.

Edit

Select Edit from the Buffer menu to open either the Fuse Buffer Edit window or
the Data Buffer (HEX/ASCII) Edit window.

Use the following keys to edit the buffer data:
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U
0
U
0

Press the Page Up key to Page up in the data window.

Press the Page Down key to Page down in the data window.
Press the Home key to move the cursor to the beginning of the line.
Press the End key to move cursor to the end of the line.

The following sample illustrates an example with two data buffers. The red labels

refer to the numbered explanations below.

Buffer Edit X

~

00000000 67 02 00 00 O1 24 00 00-00 75 73 62 31 30 20 73 goO0..0¢...usb10 s
00000010 65 72 69 61 6C 73 00 00-00 OB 10 35 BO F7 99 76 erials...005...v
00000020 68 99 98 2B A2 A3 35 FF-89 01 00 00 00 02 0S5 00 h..+..5..0...00.
00000030 00 0O 41 54 4D 45 4C 03-07 00 OO OO 41 54 38 39 ..ATHMELOO...AT89
00000040 43 35 31 04 00 OO 0O O0-05 01 OO OO 0O OS5 06 OO CSi0....00...00.
00000050 00 0O 00 07 D4 OO0 00 OO0-00 OO OO OO0 OS5 04 0O 00 0 s oo
00000060 00 OO OO OO OO0 09 01 0O0-00 OO OO OA O4 OO 00 OO ..... 2 BTS2 ol
00000070 00 00 00 0O OB 04 00 00-00 OO 10 00 00 OC 04 00 oo....0..00.
00000080 00 OO FF OO OO OO OD 04-00 OO OO OO OO OO 0O OE  ...... 6 o
000000S0 04 0O OO OO OO 10 OO OO-OF 04 OO OO OO FF OO OO O....0..00......
000000AD 00 10 04 00 OO0 OO 0O OO0-00 OO 11 O1 00 00 00 01 .00....... og...o
000000BO 12 01 00 OO OO O1 13 0O1-00 OO OO OO 14 01 00 OO OO...000....00
000000CO 00 01 15 04 OO0 OO0 OO FF-OF OO OO 16 04 00 0O OO ooo....0..00
000000ODO  FS OF 00 00O 17 04 00 00-00 01 OO OO0 00 18 04 OO0 0..00...0...00
000000OED 00 OO 03 00 OO OO0 19 01-00 OO OO OO 1A O1 OO OO ..0O...00....00
000000FD 00 00 i1C 17 00 OO0 00 O0-00 OO OO OO0 00 00 00 00 ..0....eennnnn. Z
‘|Address: 00000000H lChec}csum: OOODDDEAH [¥] Buffer clear at IC Change
) Buffer clear on data load
JBuffer range: 00000000H - OOOOOFFFH DBuffer ave Wheniawit
[Locate H Copy H Fill ][ Search ” Search Next ” Radix ” Swap ]

IZ)uplicate I | OK |

Note: You can open several data buffers at the same time from the toolbar.

1. The tabs in the lower left corner allow you to switch from one data buffer to

another. The current data buffer name is highlighted.

2. Select Duplicate to save the data in the buffers in text form. The following

examples show the text form of the saved buffer data.

1 HEX/ASCII data buffer:

00000000
00000010
00000020
00000030

4D 5A 90 00 03 00 00 00-04 00 00 00 FF FF 00 00
B8 00 00 00 00 00 00 00-40 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00-00 00 00 00 00 00 00 00

00 00 00 00 00 00 00 00-00 00 00 00 80 00 00 00

1 Fuse data buffer:
10011010101010101010101010101010
01101010101010101010101010101010
10100110101010101010101010101010
10101010011010101010101010101010
10101010101001101010101010101010

00000768
00000800
00000832
00000864
00000896
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00000928 10101010101010100110101010101010
00000960 10101010101010101010011010101010
00000992 10101010101010101010101001101010

HEX/ASCII Data Buffer

When you select Edit from the Buffer menu with the appropriate file type, the
system opens the Data Buffer (HEX/ASCII) Edit window, illustrated below.

00000000 gO..0§8...usbl0 s =
00000010 65 72 69 61 6C 73 00 00-00 OB 10 35 BO F7 99 76 erials...005...v
00000020 68 99 98 2B A2 A3 35 FF-89 01 00 00 OO 02 05 00 h..+..5..0...00.
00000030 OO0 00 41 54 4D 45 4C 03-07 00 00 OO 41 54 38 39 ..ATMELOO...ATSS
00000040 43 35 31 04 00 00 OO 0O-05 01 00 OO OO OS5 06 OO0 (C510....00...00.
00000050 00 0O 00 07 04 00 OO OO-0O OO OO OO OS5 04 OO0 OO ...00....... Ll &
00000060 OO 0O OO OO 0O 09 01 00-00 OO OO OA O4 OO OO OO ..... Bl ssealaes
00000070 00 00 00 0O OB 04 OO 0O0-0O OO 10 OO OO OC 04 OO ....00....0..00.
00000080 OO0 DO FF OO OO OO OD O4-00 OO OO OO OO OO OO0 OE  ...... I P u}
0ooooo0sS0 04 00 00 OO OO 10 OO0 OO-OF O4 OO0 OO OO FF OO0 OO 0O....0..00......
0o0DoO0OAXD OO 10 04 0O OO OO OO 00-00 OO 11 O1 OO OO OO 01 .00....... oa. ..o
0000OOEO 12 01 OO OO OO 01 13 01-00 OO OO OO 14 01 OO0 OO OO...000....00..
goooooco 00 01 15 04 00 OO0 OO FF-OF OO OO 16 O4 OO OO OO .000....0..00...
QooQoopo F8 OF 0O OO 17 04 OO0 OO-00 O1 OO0 OO0 OO 18 04 OO .0O..00...0...00.
O0OOOOOED OO OO 03 00 00 00 19 01-00 OO OO OO 1A O1 OO OO . .0...00....00..
00000DOFO 00 00 1C 17 00 00 OO0 00-00 00 OO0 OO0 OO 00 00 00 ..0....vvenennn F

|1deress: 00000000H Checkswu: 000DDDEALH [v] Buffer clear at IC Change
[¥] Buffer clear on data load

lBuffe): range: 0000000O0OH - OOOOOFFFH [ Butfer save when exit

[ LocateJ [ Copy J[ Fill J[Search]l Search Next Jl Radix Jl Swap J

The HEX/ASCII data buffer is 8-bit wide. Press the TAB key to switch between
HEX and ASCII data for editing.

Note: Remember that the value of start address must be less than that of the end
address.

—_

Select Buffer clear at IC change to clear the buffer after selecting the device.
2. Select Buffer clear on data load to clear the buffer before loading the file data.

3. Select Buffer save when exit to save the buffer data when exiting. This option
also loads the saved data automatically the next time you enter the system.

4. Select Locate to open the Locate Buffer dialog box. Enter the address of the
data you wish to display and select OK to quickly move the cursor to the
desired location.

5. Select Copy to open the Copy Buffer dialog box.
[1 Enter the start address in the Start Address field.
[1 Enter the end address in the End Address field.
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] Select OK to copy the data between the start address and the end address,
beginning with a new address. Otherwise, select Cancel.

7. Select Fill to open the Fill Data Into Buffer dialog box.

(1 Enter the desired data in the Fill Data field. The data consists of HEX
numbers, such as AA, 55, E4 for the Data Buffer (HEX/ASCII data) Edit
window.

] Enter the start address in the Start Address field.
I Enter the end address in the End Address field.
1 Select OK to fill the data. Otherwise, select Cancel.
8. Select Search to search for a specified string.
9. Select Search Next to begin the next search for the specified string.
10. Select Radix to toggle between the HEX and DEC memory address display.
11. Select Swap to open the Word Swap dialog box, illustrated below.

[ )

Word Width
® 16 Bits ( 2 Bytes )
(32 Bits ( 4 Bytes )

(B4 Bits (3 Bytes )

| OK J[ Cancel l

Select the Word Width option to swap high byte and low byte according to the
specified width in the address range and select OK. Otherwise, select Cancel.

For example, if the data buffer address 0-10(HEX) is:
123456 78 90 AA BB CC - DD EE FF 11 22 33 44 55

Then after swapping the data, it would look like this according to the selected
word width:

] 16 Bits (2 bytes) -
34127856 AA 90 CC BB - EE DD 11 FF 33 22 55 44

] 32 Bits (4 bytes)-
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7856 34 12 CC BB AA 90 - 11 FF EE DD 55 44 33 22

] 64 Bits (8 bytes)-
CCBB AA 90 78 56 34 12 - 55 44 33 22 11 FF EE DD

Fuse Buffer

When you select Edit from the Buffer menu with the appropriate file type, the
system opens the Fuse Buffer Edit window, illustrated below.

00000032 01000000000000000000000000000000
00000064 00100000000000000000000000000000
00000026  00010000000000000000000000000000
00000128 00001000000000000000000000000000
00000160 00000100000000000000000000000000
00000192  00000011000000000000000000000000
00000zz4 00000000100000000000000000000000
00000256 00000000010000000000000000000000
00000288 00000000001000000000000000000000
00000320 ODODODDDDDD10000000000001@000000
00000352 00000000000010000000000100000000
00000384 00000000000001000000001000000000
0000041 00000000000000110000010000000000
00000448 00000000000000001000100000000000
00000480 00000000000000000101000000000000
00000512  00000000000000000010000000000000 h<
<

[

’Address: 00000345 [¥] Buffer clear at IC Change
[v] Buffer clear on data load

]Buffer range: 00000000 - 00004095 Al comn i e

[Locate] [ Radix ] [ il ]

The data for editing is either 0 or 1. Refer to the data manual of the device and the
JEDEC to determine which of the following explanations for the data apply.

] 1represents an intact fuse and 0 represents a blown fuse
1 1represents a blown fuse and 0 represents an intact fuse

Refer to the HEX/ASCII Data Buffer section on page 28 for more information about
the options on this screen.
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Encryption table

A data buffer corresponding to the encrypted data is called an encryption table.
Whether an encryption table exists depends on the data manual.

Select Encryption Table from the Buffer menu to open this special data area,
illustrated below.

LDDRESS | | HEX | | ASCIT o
00000000 F FF FF FF FF FF FF FF-FF FF FF FF FF FF FF FF ...t iininenns
00000010 FF FF FF FF FF FF FF FF-FF FF FF FF FF FF FF FF ... .ciiiinninnnns
00000020 FF FF FF FF FF FF FF FF-FF FF FF FF FF FF FF FF ...t iveceacans
opoooos3o  FF FF FF FFFF L.

Iﬁ.ddress: 0D000000H [¥] Buffer clear at IC Change
Buffer clear on data load

|Buffer range: 00000000H - 0O0OO0O0O0D0O34H I:]Buffer L

[isccasalll ccoradll rase Il sescci [ senscumceullamcisall s snspi]

— S e m———
<[>\ Flash Tes:W//)

The Encryption function on the Function Items for Operations on Devices screen
writes the encryption table data into a chip. In most cases, you cannot check the
chip after the data is written into the encryption table. The encryption table data
also cannot be read.

Test Vector Table

The test vector table is a special data area. The data buffer corresponding to the
data is called the test vector table.

If a test vector table is included in the JEDEC file, the software loads the test vector
table into the buffer when you the file. Each line displays one vector. Each bit
represents one pin’s test characteristic. The bits from left to right correspond to the
pins from the first to the last respectively.
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A sample vector table is illustrated below, with definitions following.

V0000001

:Input low
Vooooooz2

V0000003
V0000004
V0000005
V0000006
V0000007
V0000003
V0000003
V0000010
V0000011
Vooooo01z
V0000013
V0000014
V0000015
V0000016
V0000017
V00o0o01s
V0000015
Voo000zo
Voooooz1
Vooooozz
V0000023
VO0oooz4
VO00000zZ5
V0000026

<[> I\ Flash ) Tes

] Z: High impedance state

:Input high
:Output low
:Output high
:Pulse Input
:High
Impedance
X:No Care
G:GND

WViVCC

L B T = - S -

Line:0001
Column: 0001

1 X:No care state

7 N: VCC or GND (non-test input pins)
1 H: Output Logic High (VOH)

1 L: Output Logic Low (VOL)

1 C: Clock pin

1 1: Input Logic High (VIH)

7 0: Input Logic Low (VIL)

Device Menu

The Device menu allows you to select the device.

Important: Select the device before any other operation to ensure the programmer
selects the proper algorithm for the name and manufacturer of the
device.
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Select Device

The Device menu opens the Device Selection dialog box, illustrated below.

Search Device Type
\ ®ALL
) E(E)PROM/
Manufacturer : Device Name : O FRAM/NYRAM
ABOV ~| |AT52BRIB74@CBGASE ~
ACTRANS ATE2BRIG74T@CEGARS OB/PROM
ADVANCE GROUP AT52BR3218A@ CEGABE O DRAM/SRAM
ALL245ERIES AT52BR3218AT@CEGABE -
ALLIANCE ATE2BR3Z24AG CEGARD OPLD
ALTERA ATE2BR3Z24ATE@CBGAEE
AMD AT52BR3228A@CBGALE O MCUMPU
AMIC ATE2BR3IZZBATECBGAEE
ANACHIP ATE2BR3244@CBGABE
APLUS FLASH AT52BR3244T@CEBGABE m
ASAHI KASEIAKM) AT52BR3248@CBGARE _
ASD AT52BR3248T@CBGALE oK
ASI ATE2BRB40BAG CSPER
ATC AT52BRE408ATECSPEL m
ATMEL ATBOFS1
AUSTIN ATBOFS1@FPLCC44
BMT ATBOFS1@TOFP44
ERIGHT ATB0FS2
CATALYST ATBOFS2@PLCCA4 ‘ mEl
CERAMATE ATBDFEQ% TOFP44
CHINGIS Al ~TE9CE1 v¥| |logo of
manufacturer
orted by Programmer Models: /SP500P /SP501S /SPE000E /SP5000

The device is supported by the
programmers listed on the right.

To select a device, complete the following steps.

1. Select one of the following Device Type options. If you are not sure
which option to choose, select All

E/EPROM (including EPROM, EEPROM, FLASH)
PLD

B/PROM

DRAM/SRAM

MCU

I I N O

2. Select the manufacturer in the Manufacturer column. The dialogue box
displays the manufacturer icon in the lower right corner.

3. Select the device name from the Device Name column. You can also

Superpro®5000 User’s Guide 33



double-click the device name to confirm your selection.

NOTE: The chip’s printed name may include the parameters (i.e., speed,
temperature, encapsulation, etc.). If the name is different than what
appears in the Device Name column, you may ignore the difference or
ask for help.

You may use the Search box to help select the device from the large quantity of
devices listed. Enter the first few characters of the device name to limit the number
of choices listed in the Manufacturer and Device Name columns. For example, if
you enter 89 in the Search box, the list only shows Manufacturers and Devices that
contain ‘89’. The sequence of the characters is important. For example, if you enter
‘89, the list includes “‘819’, and ‘DA8S9’ but not “98’.

4. Select OK.
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Dev. Information

Select Dev Information from the Device menu to open the Device Information.

A sample is illustrated below.

General Information

Manufacturer— SPANSION
Type~~ S71PL127NBOHAW4AB@FEBGAGS
ickage : FBGAG4 key information
o C¥5001 about this device
. —\_\\
ithm Name : FWI N A7 “,rder id
of the adapter

Device Informati

Note:
1) This device ains a special OTP block (we call Hidden . And the
Sector is ¥7ided into two areas, e

Customer-Lockable Area which can be programmed and protected by cusco -
and ctory-Locked Area which can only be read by customers.

2 {1 The OTP bhlock is located in "Hi_Rom" buffer from Ox000000H to OxOO001FFH.

OTP hlock Hi_Rom buffer address
Factory Region (Only Read) Ox000000 -  OxO000FF
omer Region (Can Program) 0x000100 -~ OxO001FF

special
information of
the deivce

Adaptor Information /

This ar is one-time programmable.

,ff/

s
O

The picture below show th it e device in the socket of
the adaptor (T Bw) -H\\\\\\\\\\\

adapter’s information

\v/

/
\
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The device information includes the following information:
[l Key information about the devices

] The manufacturers’ requirements

1 The conventions on the special devices

Note: Some devices may have special requirements, including the
arrangement of the data buffer content, and the explanations on
the special operations of the device. Read the information carefully.

To ensure correct programming, arrange the data and prepare the
corresponding settings according to the requirements. You can also
find this information in the data manual of the device.

[l The adapter information, which may include the order number (such as
CX5001), the size of the chip, and the chip insertion direction.

Note: To program chips with other than the standard encapsulation, you
must purchase the appropriate adapters.
Chip Insertion — DIP Encapsulation

Insert the chip with the notch upwards, aligning the bottom line with the bottom
line of the socket. The diagram below illustrates the process of inserting a 28-pin
chip.

—

.
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Chip Insertion — None-DIP Encapsulation

Socket adapters are available for other encapsulations, including PLCC, QFP, and
SOIC. Refer to the Adapter Information on the Device Information screen. The
insertion follows the position of pin 1.

To identify pin 1 of the chip, look for a solid square or dot on the chip that gives
the information about the chip. It also indicates the first pin of the chip.

Direct-connect:
For 144-pins adapters, connect directly to programmers.

Indirect-connect

For 48-pins adapters, insert into DIP of the programmer.

Note: 1. Generally, the pins of the chip are downward when they are inserted.
However, as for the chip PLCC20, its pins should be upward.. This
insertion is called the “Dead Bug” method.

2. SUPERPRO/5000 and SUPERPRO/5000E support 144 pins while
SUPERPRO/501S and SUPERPRO/500P only support 48 pins.

Device Configuration Word

Important: The device configuration word varies from device to device. Refer to
the device data manual for more information about the configuration
words. Set the configuration words according to the requirements of
your target system. Otherwise, you cannot use the device normally
even if it is normal when preparing and verifying the program.

Some single-chip microcomputers allow special working modes, such as the
storage area mapping, the watchdog time, the clock, or the encryption. Set these
special modes through the Device Configuration Word option.

The user files contain the configuration words of some devices. When you load
these files, the system automatically loads the configuration words into the
configuration word buffer. However, you must select the configuration words for
some devices manually.

Select Device Configuration Word from the Device menu to open the
ConfigWord dialog box. The following sample illustration shows the
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configuration word for DALLAS DS89C420. It contains the watchdog and
three protection modes.

ConfigWord @
Pagel I
‘Watchdog POR Protection Mode
(" enablefbit=0) * Mone
(¢ disablefbit=1] " Lock Bit1
" Lock Bit12
" Lock Bit123

0K | Cancel ] Help l

Some single-chip microcomputers include many items for the configuration word.
The items may appear on separate tabs or pages. Make sure to set all the items on
all pages before programming a chip.

The input of the configuration word can be divided into several ways:

[

U
0
U

The 8-bit (byte) edit box input
The 16-bit (word) edit box input
The single choice input (select and deselect, choose one out of two)

The multiple choice input (choose one out of many)
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The configuration words for chip programming are classified into two categories:

[l If the configuration word contains some protected items, then you cannot
verify the items after preparing the program. When preparing the program, the
programmer automatically shields the protected items and writes the other
items. Select Security or Protection to write the protected items.

Note: If you select None as the Protection option, the system does NOT carry
out an operation when performing Security or Protection.

] In some devices, the configuration words cannot be separated, so the system
does not write the configuration word when preparing the program. To write
the configuration word in these cases, select the corresponding item, such as
Write_Option.

Some FLASH devices also use the configuration word for the Protect operation
and to execute and display the segment protection. Refer to the Device Operation
Window section on page 55 for more information.

Option Menu

The Option menu includes items to help you program in a specific mode to meet
the targeted system requirements. Before programming a chip, make sure to select
the necessary settings.

Operation Option

Select Operation Option from the Option menu to open the Operation Option
screen.

Note: Using the Operation Option to change the settings may produce minor
changes from the following descriptions.

The Operation Option screen includes four views:
1 General

1 Buffer

1 Auto.Inc

1 Count

Each view is explained in the following sections.
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General

The General view of the Operation Option screen is illustrated below.

Operation Option @

@ Option
General Insertion Test ID Check
[“]Beeper On [JSound On
“erify Mode

@ Once with Ve

@

O Twice with Voo +-5%

Auto.Inc O Twice with Ve +- 10%

O
o
c
=

I 0K ' [ Cancel J

1. For chips with 48 pins or less or for chips with an adaptor that reduces the chip
to 48 pins or less, select Insertion Test to have the programmer check the pin
contact status before programming. The test includes a check for poor contact,
wrong direction, chip insertion, and chip insertion orientation errors. Refer to
Insertion Test on page 82 for more information.

2. Select ID Check to have the programmer read the Electronic Identifier
Code from the chip to identify the manufacturer, the device type and the
programming algorithm code. If you have already selected the device, the
default for this option is checked. Refer to Device ID Check on page 83 for
more information.

3. Select Beeper On to turn the beeper on or off. The beeper makes a sound to
indicate the results of operations such as Insertion Test error, ID unmatched,
programming successfully completed or failed.

Note: Not all programmers include a beeper.

4. Indicate the mode for verifying the data by selecting one of the Verify
Mode options. These options refer to the voltage of the pin VCC, which may
vary when the programmer verifies the data. The manufacturer provides
the MinVcc and MaxVcc values for verifying the data.
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VCC(+/- 5%) or VCC(+/- 10%) is adopted for the verification. If VCC =
5.00V, select one of the following options:

1 VCC=5.00V and verify the data once
1 VCC=4.75V and VCC =5.25V, and verify the data twice (+/- 5%)
[l VCC=4.50V and VCC=5.50V, and verify the data twice (+/- 10%)

Buffer

The Buffer view of the Operation Option screen is illustrated below.

@ Flash Test
General Buffer Size (Byte) : 1000H Buffer Size (Byte) : 124H
Start Address: |0 ‘ Start Address: |0 ‘
End Address: [FFF ] End Address: | 123 ‘
laa— —
Auto.Inc
Count
[ OK ] [ Cancel l

The default programming method is to program the device from the start address

to the end address. However, you may choose to program only a part of the chip,
such as with most E/EPROM (FLASH) devices.

Note: Most single-chip microcomputers do not allow a change to the start
address of the device.

1. For each file, enter the Start Address.
2. For each file, enter the End Address.
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EXAMPLE: The device MACRONIX MX29F200B TSOP48 is a 16-bit flash device.
Its programmable zone starts at the address 0 and ends at the
address 1FFFF (hexadecimal system).

The buffer size in bytes is (IFFFF+1) * 2 = 40000 (hexadecimal
system).

Because it is a 16-bit (2 bytes) device, the buffer size is twice as large
as the device size.

To program only the second part of the device, enter 10000 as the
start address and leave the end address unchanged. This correlates
the programming data to the buffer data between the address
10000*2 = 200000 and 40000.

Auto Increment

The Autolnc view of the Operation Option screen is illustrated below.

Operation Option @

@ [MlEnable Autolncrement;
General
Autalne. Option Autolnc.Format
@ Start Addr. | FFF | © Binary
Buffer End Addr: | FFB | O ASCIl Decimal
@ Inc. Step: ‘1 ‘ O ASCI Hex
Auto.Inc ; et T T
DUSﬁLsLstﬁnmﬁ'ﬁ'— «\\\\
Count ( ! \ )
. — 4
\ must be authorized! /
[ oK I [ Cancel ]

Auto Increment provides two methods of generating the serial numbers: Auto
Increment and User Defined. This function is not available in stand-alone mode.

Note: The serial number is the content required by some applications that must
be written in a certain area for every chip. This information includes the
product sequence number and the MAC address.
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To have the software generate the serial number, select Enable AutoIncrement.

1.

Enter the automatic start buffer address in the Start Addr field.

2. Enter the automatic end buffer address in the End Addr field.
3.
4

Enter an increment value less than 10 in the Inc. Step field.

. The AutoInc Format defines the start value and the overflow value. The

overflow value is the number at which the increment ceases and carries to the
next address, which becomes the new start value.

1 Select Binary to set the start value as 0 and the overflow value as 256.

1 Select ASCII Decimal to set the start value as 30 (hexadecimal
representation of 0) and the overflow value as 39+1 (the hexadecimal
representation of 9).

1 Select ASCII Hex to set the start value as 30 (hexadecimal representation of
0) and the overflow value as 46+1 (the hexadecimal representation of a
number greater than F, where 9+1=A).
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Example: There are 64 chips with IDs from 0001 to 0064, which are in the end
address of 89C51 EPROM. The selected mode is 4 bytes, using the
decimal system.

1. Enter FFF in the Start Address field.

2. Enter FFC in the End Address field.

3. Enter 1in the Inc.Step field.

4. Select ASCII Decimal as the AutoInc. Format.

In the Buffer Edit window, make the following change:
FFC: 30 FFD: 30 FFE: 30 FFF: 31

The Operation Information window displays the following
information during programming;:

Current AutoIncrement Data=0001

In subsequent programming operations, the information in the last 4
bytes of the buffer data is:

FFC: 30 FFD: 30 FFE: 30 FFF: 31

After successful programming, the AutoIncrement value increases
by 1. The Operation Information window displays the following
information:

Current AutoIncrement Data = 0002

The last 4 bytes of the buffer data are:

FFC: 30 FFD: 30 FFE: 30 FFF: 32

To define the increase of the serial number, select User’s Definition. You must be
authorized to use this function. If so, you can change the data as desired in the 4K
byte range.
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Count

The Count view of the Operation Option screen is illustrated below.

Operation Option @

@ Program
General 7 IRead

@ [Cverify

[ Blank_check

Buffer
[JErase
N ClLock_Bitt
Auto.Inc [JLock_Bit12

' oK I [ Cancel ]

This screen allows you to change the default setting regarding the statistical work
of the programming status. In the default case, it is only effective for the function
“program”.

Edit Auto

The Auto function organizes the different functions of the device into a sequential
group and carries out the functions in order, similar to a batch command.
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Select Edit Auto from the Option menu to open the Edit Auto screen, illustrated
below. The illustration is a sample for the device ATMEL AT89C51.

x

Device Functions: Auto:

Program Erase

Read Blank_check

Program

Blank_check |h
Lock_Bit1

Lock_Bit12

Lock_Bit123

OK

il

Cancel

The Device Functions column displays all operations for the device.

The Auto column lists the operations in order of execution. For the sample in the
illustration, the operation execution order is Erase, Blank_check, Program, Verify,
Lock_Bit123.

1. Select Add to add the highlighted function in the Device Function column to
the end of the Auto column. You can also double-click the highlighted function
in the Device Function column to add it to the Auto column.

2. Select Delete to delete the highlighted function in the Auto column. You can
also double-click the highlighted function in the Auto column to delete it.

3. Select Delete All to remove all the functions from the Auto column.

Production Mode

Select Production Mode from the Option menu to program devices in large
quantities. With the help of the Insertion Test, the programmer automatically
detects the insertion and taking-out of the devices and carries out the whole
programming process. In this mode, the user does not need to use his mouse or
keyboard.

If you receive a non-support information message, the selected device does not
support production mode.

Refer to the Execute Production Mode section on page 66 for more information.
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Log File

You can create a log file to have the system save Operation Information window
content into a log file when you exit the program. Select Log File from the Option
menu to open the Log File dialog box, illustrated below. The red labels refer to the
numbered explanations below.

Lag file 0K
O Mo 1
Cancel
@) New 2

O Append 3

Log file's name:

‘ CASPS000hInY og. txt 4 ‘ Browse

1. Select No to delete the log file. The system will not create a log file on exit.

2. Select New to overwrite the existing log file every time the program starts.

3. Select Append to add the log file information at the end of the existing log file
each time the program starts.

4. Enter, edit or Browse for the full path name of the log file in the Log file’s
name: field.
Project Menu

The project file is a place to save all of the preparations before programming. You
can also use it to restore the saved working environment. The project file includes:

(1 The current device's info, such as:
— The manufacturer name
— The device type
— The information about the pin
— The size
— The data file name

— The current buffer data
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Note: The buffer data may differ from the data file due to revisions. The
revised buffer data prevails.

1 All Operation Option settings
I The content of the Auto mode

Note: The project content is related to the programmer software. If the software
has upgraded or has been re-installed to another folder, the saved project
files become ineffective.

Load Project

Select Load Project from the Project menu to load a project file. Select the file in
the File dialog box.

Save Project Files

Select Save Project Files from the Project menu to save the current working
environment to a specified project file. To ensure the security of the data, you can
encrypt the project file. Refer to Security and Password Input on page 66 for more
information.

Downloading Library (Standalone)

The standalone operation is when the programmer hardware is not connected to a
computer, and uses information saved in its own module for volume production.

The standalone file includes all the information needed for programming the
device. Make sure to prepare the standalone file before starting the programmer’s
standalone operation. Refer to Operation Instructions for Stand-Alone Mode

I. Introduction

SuperPro5000 incorporates dual operational modes.

(1 PC Mode Operation: Programmer is connected to a PC via a USB port
and all operation is performed through the PC. This mode is used for
engineering and development as well as small volume production.

[l Stand- Alone Mode Operation: All operation is performed through the
attached keypad and display. Prior to operating in Stand-alone mode,
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relevant programming data and information has to be downloaded into
the programmer memory, Compact Flash (CF) card. Device programming
algorithm, user data, device configuration, “Auto” programming sequence,
etc. are conveniently combined into a project file for download making the
user operation simple.

Compact Flash card can store multiple project files as much as the memory space
allows. It also provides data buffer area for programming. For example, a 4GB
card can store hundreds of project files. This mode is used for volume production
operation.

II. Screen Menus

There are al6 characters by 4 line LCD panel and a keypad for user operation in
stand-alone mode operation. Screen menu and function list are as follows.

RUN Menu

AUTO Execute a sequence of functions user defined and stored in
the project file. This includes one or more of the functions
listed below.

PROGRAM Program a chip with the data in the buffer.

READ Reads a chip and saves in the buffer (CF card). (Please
don’t change the data in the project file).

BLANK CHECK Check whether the chip is blank or not

VERIFY Compare the programmed data with the buffer data.
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ERASE Erase the chip

SECURE Protect the chip

SELECT PROJECT Menu Select a project using . « ., and ENTER keys. Selected
project data are loaded into the buffer.

BUFFER Menu

DISPLAY BUFFER  Display the content in the buffer. Press ENTER to display
start address and data and - or - to move the cursor to the
address to be modified, then use + or 1 to change the

address.
LOAD PROJ DATA Load the current project data to the buffer.
CHECKSUM Calculate the checksum of the buffer data and compare

with the value saved last time. If they are different from
each other, display the checksum values of both.

SETTING Menu

Some configurations of the project loaded can be modified. It should be noted that
the changes made are not saved. Therefore, the original project data will be
loaded in when called the next time.

PRODUCTION MODE When enabled, a chip inserted is checked and
programming operation begins automatically. Use + or
1 key to select “Enable” or “Disable”. Default is “Enable”.
A user only has to remove a chip and insert a blank chip
for automatic programming operation.

AUTO CHECKSUM Checksum value is provided automatically before
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programming operation begins. Use + or : key to select
“Enable” or “Disable”. Default is “Enable”.

READ OPTION Reads the chip content and saves into the buffer for visual

inspection. Use + or : to select “Enable” or “Disable”.
Default is “Disable”.

PIN CHECK Proper insertion of the chip is checked before
programming begins. Use + or . to select “Enable” or
“Disable”. Default is “Enable”.

BEEPER Sounds beep at end of programming operation. Use + or
i to select “Enable” or “Disable”. Default is “Enable”.

III. Keypads

ENTER Select and enter the submenu

EXIT Exit to the previous menu.

t Or 4 Scroll to select. Change data at the cursor location when editing the
buffer.

~OF Scroll to locate an address or data in editing the buffer.

IV. Important Information

If the buffer data is changed improperly, improper programming and loss of
data may result. Please check the following advice:

(1 Compare the checksum in the buffer and the original project data. (usually

before the production)
[ READ operation may change the content in the buffer. READ function
should be disabled for normal operation. Run LOAD PROJ DATA

function to restore the project data.
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VI. Standalone Operation

After the necessary project file(s) is downloaded into the CF card, turn the
programmer OFF, disconnect the programmer from PC, and turn the
programmer ON again.

1. Press “Enter” and “SELECT PROJECT”. Use + or . to select a project
for programming.

2. Press “EXIT” and “RUN”, then select “Auto” or other functions to
program a chip.

Downloading Library Creation on page 67 for more information.
Select Standalone from the Project menu.

The system first checks for data in the storage module. If the system reads data in
the module, it reads the data position allocation table.

The system prompts the user for the password if password protection is
required. The system displays the following dialog box.

SUPERPRO for Windows !

||

! E Password error. The content of CF card will be deleted. Continued?

[ es ] [ Mo ]

Select Yes to delete the data in the storage module (CF card).
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The system displays the Library of Standalone Mode dialog box, illustrated below.

Libracry of Standalone Node @

Project Information
@}estprﬂ 1 ATMEL ATBIC51 40Pins Checksum:0007 CBCSH

EF Aestpri2 AMIC A29DL1B2TG@FBGA48 48Pins Checksum:10055616H
@ estprj1_0 ATMEL AT89C51 40Pins Checksum:0007CBCSH
(\}estprp_D 2 AMIC A29DL1B2TG@FBGA48 48Fins Checksum:1005561BH
/ estprj3 APLUS FLASH AF24BC04@S0IC8 8Pins Checksum:0000103BH

Download Library ] I oK

CF Card Size = 256 MBytes

The Project column first lists projects in the storage module where data

—_

already exists.

2. The Project column then lists projects in the storage module where data is
added.

3. Select Insert to add files to the project library.
4. Select Delete to delete files from the project library.
5. Select Download Library to start the downloading.

The system displays the storage capacity of the programmer hardware. In the
above illustration, CF Card Size = 256 Mbytes means the storage capacity is
256 MB.

Note: Even though SuperPro 5000, SuperPro 5000E, and SuperPro 501S support
offline mode; it is not supported by SuperPro 500P.

Help Menu

Tool Bar

The tool bar provides a quick way to execute common functions. The toolbar from
the main SUPERPRO screen is illustrated below. Each tool is labeled with a
number and described below. Refer to the corresponding functions in the Menus
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section, beginning on page 22, for more information.

B-8 € 2o
1 2 3 4 5 6

7

Load

Save

Load Project

Save Project

Factory Mode (Refer to Factory Mode on page 74 for more information.)
Calculating the checksum (Refer to the next section for more information.)

Help

N o g s L b=

Checksum

When the data type of the data buffer is ‘Data’” (HEX/ASCII data), the default
calculation for the checksum is to put together all the data from Address 0 to the
maximum address byte by byte.

You can use Checksum to specify a different way to put together the data.
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Select the Checksum tool to open the Checksum for Compeatibility screen,
illustrated below.

Checksum for Compatibility E]

Type: Defautt v|
«@ 0 1 To [2007F b
Checksum:

Calculate | (0]74

Checksum for Compatibility

Type:

Default

From: 16Bits, LSE First (Little Endian)

Bits, M5B First (Big Endian)

1. Enter the calculation range in the From and To fields.

2. Select the accumulation method from the Type drop down list.

Main Screen Device Information Display

Next to the Device button on the main screen, the system displays information
about the recently selected device, including the manufacturer name, the device
name, the size, the number of the pins, and the device types. A sample is
illustrated below.

ATMEL ATBICS1 FLASH-1D00H'S 40Pins v‘

Select the drop down arrow to choose a device from the device history. This only
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changes the device information and is not the same as loading a project file. A
sample is illustrated below.

NOVATEK NTGBFE31LG@PLCC44 20080HS 44Pins MCLUMPU v

NOWATEK NTBEFE31LG@PLCCA4 20080HE 44Pins MCUMPU
Buffer ADVANCE GROUP AF24BC0O2@TSOPS 100HS SPins E/EPROM
ATMEL ATS9CS1 FLASH:1000HE 40Pins
Operation Optio] ap| 1S FLASH AF24BCO4@SOICE 200HE SPins EEPROM

After you have selected a device, the system displays a dialog box for
confirmation. Select OK to confirm or Cancel to cancel and select a
different device.

Main Screen File Information

Next to the Buffer button on the main screen, the system displays information
about the recently loaded file. It includes the checksum information and the full
path and file name. A sample is illustrated below.

Checksum: 01FE7FB0H  File = D:\25254 _ddooo_comt111 frx v

Select the drop down arrow to load a file from the file history. This only changes
the file, not the device. A sample is illustrated below.

Buffer J Checksum; 00018F37H  File = D:\25254 _ddooo_comMicrosoft visual foxprowfpeil 11 frx v
Checksum: 00018F97H  File = 0025254 _ddooo_comiyl11 .frx

Operation Optio] -y < DO0293BEH  File = D'\25254_ddoon_comibook3 DEF

After you have selected a file, the system displays a dialog box for confirmation.
Select OK to confirm or Cancel to cancel and select a different device.

Operation Option Bar

The Operation Option toolbar provides a quick way to execute functions from the
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Option menu. The user can find the corresponding operation in the menu.

eration Option Edit Auio Dev. Info Data Compare
mp

e Operation Option: Refer to Operation Option on page 39 for more
information.

N
N

N
[]

Edit Auto: Refer to Edit Auto on page 45 for more information.

Device Configuration Word: Refer to Device Configuration Word on page
37 for more information.

Device Info: Refer to Dev. Information on page 35 for more information.

Data Compare: Refer to the section that follows for more information.

If you select a PLD device with a U-Field, the Operation Option Bar will look
like the following;:

Operation Option Edit Auto I.E.5. Dev. Info

U.E.S is the edit user electronic signature. The system may change this content
while reading the device or loading files. Users can view and edit U.E.S. (two
display methods, Hex and ASCII).

Oser Electronic Signature Bytes @

Hex: 313233343536

ASCII: | 123456]

’ DK l ’ Cancel
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Data Compare

The Data Compare function is applicable to most memory chips and SCM chips.

Select this option to compare data in the buffer and the chip byte by byte.

If the system finds differing data, it saves the address, the data records in the
buffer and the chip, and the generated list file in a ‘Bin” directory file. The
Operation Information screen displays the file name and path of the file.

Example: Compare result in file:
C:\SP3000U \ BIN\27256.CMP

The file format is shown in the following;:

Title : SUPERPRO Data Compare Result file

Displacement Buffer address Chip Data Buffer Data
000000D0O 04 12(EPROM)
000000D1 00 34(EPROM)
000000D2 00 56(EPROM)
000000D3 00 78(EPROM)
000000D4 00 90(EPROM)
000004A5 00 AA(EPROM)
000004A6 00 BB(EPROM)
000004A7 00 CC(EPROM)

Note: If there are many buffers, the buffer names (such as EPROM) will
be added. However, most buffers do not have the names.
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Device Operation Window

This window displays the operations that can be executed during programming,
as provided by the manufacturer. After you have prepared for programming, use
this window to execute operation items quickly.

The display varies depending on the chip. A sample Operation Window is
illustrated below for Atmel At89c51. Explanations for the most common
operations follow.

Note: The Device Operation Window may be different for some devices with
special requirements and functions. To obtain detailed information for
those functions, refer to the manual of the device data or the Dev.
Information screen, or contact XELTEK technical support.

*! Read
- 1.Move mouse to select

"4 Verify . .

' 2 Hightlight the selected itern

"4 Blank_check
3.Click left button of mouse
'{ Erase to execute the function

*J Lock_Bit1

"J Lock_Bit12

"J Lock_Bit123

] Auto is the automatic programming mode, which executes a series of
operations on the device in a preset order. Refer to Edit Auto on page 45 for
more information.

1 Program writes the data from the buffer into the chip and verifies the accuracy
of the programming in some cases.

Note: The Verify function is performed in two modes. The first mode checks
for accuracy on completion of programming a chip. If an error occurs,
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the system displays an error message and ceases the programming.

The second mode does not perform verification during programming.
The process continues even if an error occurs. Upon completion, the
system displays a successful programming message. However, the
message only indicates successful completion of programming. You
must perform the verify function to ensure accuracy.

] Read reads the content of the chip into the buffer. Open the Buffer Edit dialog
box to view the content.

Notes: The system cannot read the content of encrypted chips.

The system cannot read PLD devices since the test vector is not in
the chip.

If a chip includes ConfigWord, the system reads the ConfigWord data
and saves it to the ConfigWord buffer.

] Verify compares the content of the buffer with that of the chip.

Notes: If there is any discrepancy, verification ceases and the system displays
a failure message. For most memory chips and SCM chips, the failure
message includes address and data. For PLD devices, the message
displayed depends on the programming reference. Only the chips
that pass verification can be recognized as the chips being
programmed correctly.

Some chips do not provide the cell to cell check function. Instead, these
chips provide only the accumulation check function similar to the
VerifyCRC.

A few chips do not provide the accumulation check function. The system
performs the check automatically in the programming process.

1 Blank_check checks if the device is in blank state, which is dependent on the
data manual. If filling the blank data buffer is selected when the devices are
selected, the programmer will fill all the HEX/ASCII buffer data with FF or 00
(Hex), and the fuse buffer with 1 or 0 after the device is selected. An encrypted
chip may be displayed as a blank chip.

Superpro®5000 User’s Guide 60



Notes: EEPROM devices do not need Blank_check because the chip can be
overwritten.

Refer to Making a Chip Blank on page Error! Bookmark not defined.
for more information.

1 Erase erases the chip and makes it blank. This operation can only be executed
on the chip that can be erased electrically. EEPROM does not need to execute
this operation. If you need a chip with a blank state, you can directly write the
blank data to the chip. Some chips that can be erased electrically are able to
become an OTP by configuring the ConfigWord. Please refer to the device data

manual.
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] Protect encrypts data to make it unreadable. Protect affects the
operation function whether it is readable or not.

— When the protection state is unreadable, the system displays the Protect
operation in the operation function window. Execute the Protect function to
protect the chip.

— If the protection state is readable, the Protect options are part of the
ConfigWord. Select None to have the system perform no protect function.

Note: If the chips made by some manufacturers are fully protected, the
data cannot be erased even with the ultraviolet ray eraser. These
chips cannot be re-used.

— The Protect function protects the data in FLASH chips. You cannot rewrite a
protected chip until you have removed the protection. Use the Erase
operation to remove the protection. You must use this operation with Dev.
Contfig and identify the sector. Refer to Identifying the Sector on page 73 for
more information.

Security encrypts data to make it unreadable.
Erase_All is the same as Erase.

Protect_All is the same as Protect.

0 I ) A N

Lock_Bit is a protection method. Please refer to the Device Data Manual for the
detail information about the operations.

Example: Atmel At89c51 has three operation items: Lock_Bit1, Lock_Bit12,
Lock_Bit123. The data manual defines the meaning of each.
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Operation Information Window

The Operation Information Window displays interaction between the software
and the user. The system displays the operation process, the operation result and
the historical records of information in this window. A sample is illustrated below.

THMEL AT89CH1
rasing ..

rase OK!

lank Checking ...
lank Check OK!
rogramming ...
rogram DK!
erifying ...
erification OK!
ock Bit 1&2&3 ...
ock Bit 1&2&3 OK!
D:00'09"23 elapsed.
rogrammer not found!

The system displays successful operations in green and errors in red. If errors
occur, read the error information to determine the problem.

Status Bar

The status bar displays the menu item info, the progress of operation, and a
Cancel button. A sample status bar is illustrated below.

Ready 37%  [WNNRANNNEEN | [CANCEL

Select Cancel to stop the current operation. The system displays a dialog box to
confirm the cancellation. The operation continues until you confirm the
cancellation.

Note: The ‘Cancel” operation may destroy the chip. Use it carefully.

Superpro®5000 User’s Guide 63



Statistic Window

The Statistic Window displays statistical information. A sample is

illustrated below.

Success: \

2,
Failure: | D

|

Total; E i

Count down:
Count Total:
Remains:

' Disabled
0

[ Reset Count Down ]

The system displays the number of times according to the default counting rules:

] Success: successful programming
[l Failure: failed programming

[l Total: total programming

The default counting rules:

] After successful Program execution, the Success count increases by 1.

Otherwise the failure count increases by 1.

[ After successful Auto execution (if Auto includes the Program function),

the Success count increases by 1. Otherwise the failure count increases by 1.

Select Reset to set the successful times and the failed times back to 0.

Select Reset Count Down to open the Count Down dialog box, illustrated below.
The red labels refer to the explanations that follow.

Total: |100 1

[¥] Count down : enabled 2
] Stop when reaching the total 3

1. Enter the number of chips you are programming (greater than 0) to have the

system count down. The Count Down number decreases by 1 every time a

chip is programmed successfully, until it reaches 0.
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2. Check the Count Down: enabled box to enable the count down function.

3. Check the Stop when reading the total box to ensure that no more programs
are written until you reset the option.

Muti-programming

This function is only provided by SUPERPRO 5000,SUPERPRO 5000E,
SUPERPRO 501S. SUPERPRO/500P doesn’t support this function (Take
SuperPro 5000 for example).

SuperPro 5000 can be connected to hub. You can connect four SuperPro 5000s or
one SuperPro 5004GP to hub.

Find muti_p.exe at the “bin” folder under the directory where your SuperPro
5000’s software is installed. Following interface shows up after you run it.

muti programmer E]‘E @
5 §, DisCornect P Setting & x] @ Quit

Status
Message Serial Number

‘ No programmer |

2 ‘ No programmer.

w

‘ o programmer

‘ No programmer.

Output Statistic
_____________ Hulti-programmer starts —------------ Success Failure Sum Yield
Current time is 5/19/2008,14:53:49.
Load initial file: administrator mode. #1 0 ] 0 0.0 %
Programmer #1 :Success:0,Failure:0,Total:0.
Prograxmer #z :Success:0,Failure:0,Total:0. 22 0 0 0 0.0 %
Programmer #3 :Success:0,Failure:0,Total:0. .
Y
Programmer #4 :Success:0,Failure:0,Total:0. #3 0 0 0 0.0 %
211 Programmers :Success:0,Failure:0,Total:0. 14 0 0 0 0.0%
Count down : disabled.
Connect all programmwers. All 0 0 0 0.0%
Count Total: 0
Count Remain: 0 Reset Count Down
j <|» I\ Ma'n/< #1 >\ #2 >\ #3 >\ 4 / SUPERPRO Uiy ersal Preog-ammers

“muti_p.exe” can manage four modules (4 SuperPro 5000s or 1 SuperPro 5004GP
) concurrently. The main screen is a management interface that controls the
hardware of the programmer by sending commands to the SuperPro 5000
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software. As the main interface appears; the process of communicating with
the SuperPro 5000 software starts automatically.

If the system can not detect the programmer or something goes wrong with a
module, select DisConnect to cancel the connection. First, check the connection
between the hardware and computer or the module and the programmer.
Then, select Connect to reconnect. Refer to Other Messages on page 72 to get
more information for troubleshooting.

“muti_p.exe” has administrator mode and producer mode. In administrator mode,
users can set projects and save them. In producer mode, users can load project
those have been saved in administrator mode. In producer mode, users can load
different projects for different modules or same project can be loaded for all the
modules. It’s very convenient and flexible.

NOTE: The hub used to connect SuperPro 5000s, should be specified by
XELTEK.
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Chapter 4 Procedures

This chapter provides information on steps for common procedures.

Programming Procedure

This section presents the operation process for the chip programming, from the
beginning to the end, including the user interface and the device programming
steps.

Before you start to program any devices, make sure that you have correctly
installed the programmer and that the computer is successfully communicating
with the programmer.

Prepare the Hardware

Before using the programmer to program a device, make sure that the
programmer is installed properly, and that the PC and programmer are
communicating successfully.

Make sure that you have the appropriate adapter for your SMD devices, if
applicable.

Insert the chip correctly. Follow the guidelines of the standard chip insertion
markings near the pin-driver socket. However, if you select SMD or a device that
requires non-standard insertion, the system prompts you with the appropriate
chip insertion.

Select the device

To open the Device Selection window, choose one of the following options:

[] Select the Device Selection icon

1 Select the Device menu and select the Select Device (Device) option.

The system displays the Device Selection screen. Refer to Select Device on page
33 for detailed information on the Device Selection screen.

Load Data into Buffer

Load data into the buffer by reading data either from a file or a master chip.

1 To read data from a file, select Load File from the File menu. The system
displays the Load File dialog box. Refer to Load File on page 22 for detailed
information on the Load File screen.
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After confirmation, the system loads data into the buffer.

Make sure the loaded data is correct by viewing on the Buffer Edit
window. Refer to Buffer Menu on page 26 for detailed information.

Note: Some Hex or S record files contain non-zero file start address. In this
case, enter the start address in the File Address box.

To read the data from a master chip, complete the following
steps: — Insert the master chip in the socket.

— Select Read on the Device Operation window of the main screen. The
system copies the data from the master chip into the memory buffer.

— Make sure the loaded data is correct by viewing on the Buffer Edit window.
Refer to Buffer Menu on page 26 for detailed information.

— If desired, you can save the data to a disk for later use. Refer to Save on
page 25 for detailed information on saving files.

Note: The read function is not available for some devices, including those
that have been encrypted.

Set Options

Select Operation Option from the Option menu to open the Operation Option
screen. Set each of the following options:

[]

Insertion Test option to indicate whether to check the pin contact before
programming
Device ID Check option to indicate whether to check the ID of the device

before programming

Beeper option to indicate whether the beeper beeps when the operation
succeeds or fails

Auto Increment Function option to indicate an automatic increase in the label
number written to each chip

Address Change option to indicate a different start and end address for the
programming zone of the device

Verification Mode option to select a specific VCC voltage to ensure that the
chip is programmed correctly
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Edit Auto

To set the order of the batch processing functions, select Edit Auto from the
Options menu. The system displays the Edit Auto screen. Refer to Edit Auto on
page 45 for detailed information on the Edit Auto screen.

Configure the Device

For devices that include the configuration word, you must set the configuration
word before programming to ensure that the chip can be used on the target
system.

The configuration words for some devices are contained in the data file. Therefore,
the system automatically loads the configuration word into the configuration
word buffer when loading the data file.

On some devices, you must manually make the selection. Select Device
Configuration Word from the Device menu to open the ConfigWord screen. Refer
to Device Configuration Word on page 37 for detailed information about the
ConfigWord screen.

Review the Device Information

Some devices must meet some special requirements for programming a chip,
including special algorithms conventions. Read the device manual or instructions
carefully and adjust the operation steps or buffer data as needed. If an adapter is
required for programming, the system displays information about the adapter in
the device information screen. Refer to Dev. Information on page 35 for detailed
information about the device information display.

Execute Programming

Insert the chip properly into the socket. If the prompt information indicates a need
for an adaptor, you may purchase the adapter.

The operation steps for programming a chip are follows:
1 Blank Check
Notes:You can skip this step if the chip is brand new.

The Blank Check fails on electrically erasable chips containing some
information. In this case, perform the Erase operation first. You do not
need to erase EPROM chips for which the data can be overwritten.

! Program
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[ Verify

Note: This step is necessary. The chip must pass Verification before the
programming can be implemented. Some chips provide only the
accumulation check function, such as VerifyCRC instead of a
unit-to-unit check function. Very few chips do not provide the
accumulation check function.

[ Security or Protect if encryption is required

Note: You may need to set the configuration word before performing
encryption. Refer to Device Configuration Word on page 37 for more
information.

Select Auto to finish all the operations in one step.

Execute Production Mode to Program Chips in Batches

Select Production Mode from the Option menu to program devices in large
quantities. This function facilitates the job of the user who programs chips in
batches.

In order to program chips in batches, the programmer always conducts the
insertion test.

The programmer waits for the chip insertion. The system displays the following
prompt: Please, insert a device into the socket. Refer to Insertion Test on page
82 for detailed information on chip insertion error messages.

Once you have properly inserted the chip, the auto batch-processing
command starts automatically.

The programmer waits for the chip removal. When chip programming is complete,
the system displays the following prompt: Please, remove the device from the
socket.

Review the Operation Information window to check the programming result.
Refer to Operation Information Window on page 59 for more information.

To end production mode, select Cancel on the right side of the status bar.

Security and Password Input

To prevent the user’s data from being used by another, the program asks the user
to input the password in the operation process.

The Set Password screen is illustrated below.
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Set Password @

Enter the password: ’ 1 ‘
Confirm the password: ‘ 2 ‘
QK l [ Cancel l

1. Enter the new password in the Enter the password field. Leave the field blank
to indicate no password is required.

2. Re-enter the password. Both fields must match for a valid password.
Note: Spaces are characters that can be used in the password.

The system asks for a password whenever performing a function that requires a
password. The Enter Password screen is illustrated below.

Enter Password @

Enter the password: ‘ ’

l OK ‘ [ Cancel ’

Operation Instructions for Stand-Alone Mode

I. Introduction

SuperPro5000 incorporates dual operational modes.

[ PC Mode Operation: Programmer is connected to a PC via a USB port
and all operation is performed through the PC. This mode is used for
engineering and development as well as small volume production.
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] Stand- Alone Mode Operation: All operation is performed through the
attached keypad and display. Prior to operating in Stand-alone mode,
relevant programming data and information has to be downloaded into
the programmer memory, Compact Flash (CF) card. Device programming
algorithm, user data, device configuration, “Auto” programming sequence,
etc. are conveniently combined into a project file for download making the
user operation simple.

Compact Flash card can store multiple project files as much as the memory space
allows. It also provides data buffer area for programming. For example, a 4GB
card can store hundreds of project files. This mode is used for volume production
operation.

II. Screen Menus

There are al6 characters by 4 line LCD panel and a keypad for user operation in
stand-alone mode operation. Screen menu and function list are as follows.

RUN Menu

AUTO Execute a sequence of functions user defined and stored in
the project file. This includes one or more of the functions
listed below.

PROGRAM Program a chip with the data in the buffer.

READ Reads a chip and saves in the buffer (CF card). (Please
don’t change the data in the project file).

BLANK CHECK Check whether the chip is blank or not
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VERIFY Compare the programmed data with the buffer data.

ERASE Erase the chip

SECURE Protect the chip

SELECT PROJECT Menu Select a project using . « , and ENTER keys. Selected
project data are loaded into the buffer.

BUFFER Menu

DISPLAY BUFFER  Display the content in the buffer. Press ENTER to display
start address and data and - or - to move the cursor to the
address to be modified, then use + or 1 to change the

address.
LOAD PROJ DATA Load the current project data to the buffer.
CHECKSUM Calculate the checksum of the buffer data and compare

with the value saved last time. If they are different from
each other, display the checksum values of both.

SETTING Menu

Some configurations of the project loaded can be modified. It should be noted that
the changes made are not saved. Therefore, the original project data will be
loaded in when called the next time.

PRODUCTION MODE When enabled, a chip inserted is checked and
programming operation begins automatically. Use + or
1 key to select “Enable” or “Disable”. Default is “Enable”.
A user only has to remove a chip and insert a blank chip
for automatic programming operation.
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AUTO CHECKSUM Checksum value is provided automatically before
programming operation begins. Use + or + key to select
“Enable” or “Disable”. Default is “Enable”.

READ OPTION Reads the chip content and saves into the buffer for visual

inspection. Use + or : to select “Enable” or “Disable”.
Default is “Disable”.

PIN CHECK Proper insertion of the chip is checked before
programming begins. Use + or . to select “Enable” or
“Disable”. Default is “Enable”.

BEEPER Sounds beep at end of programming operation. Use + or
i to select “Enable” or “Disable”. Default is “Enable”.

III. Keypads

ENTER Select and enter the submenu

EXIT Exit to the previous menu.

1 Or 4 Scroll to select. Change data at the cursor location when editing the
buffer.

-OF « Scroll to locate an address or data in editing the buffer.

IV. Important Information

If the buffer data is changed improperly, improper programming and loss of
data may result. Please check the following advice:

(1 Compare the checksum in the buffer and the original project data. (usually
before the production)
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[ READ operation may change the content in the buffer. READ function
should be disabled for normal operation. Run LOAD PROJ DATA
function to restore the project data.

VI. Standalone Operation

After the necessary project file(s) is downloaded into the CF card, turn the
programmer OFF, disconnect the programmer from PC, and turn the
programmer ON again.

3. Press “Enter” and “SELECT PROJECT”. Use + or . to select a project
for programming.

4. Press “EXIT” and “RUN”, then select “Auto” or other functions to
program a chip.

Downloading Library Creation

Creating Project Files

Under the standalone mode, the programmer can program the devices of the same
model according to the different requirements, or program different devices. The
maximum number of the programming methods that the programmer supports
depends on the storage capacity of the programmer hardware. The selection of the
programming method depends on the information saved in the project file.

Example: Two Atmel AT89C51 chips are going to be programmed with two
different files. If the storage capacity is enough, add an AMD
AM27C128.

You would complete the following steps:
1. Select Atmel AT89C51.
2. Load the first file for programming.

3. Edit the Auto function to include Erase, Blank_check,
Program, and Verify.

4. Execute the Auto function. After the successful completion of
the programming operation, check the chip in the target system.
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5. Save the current working environment to the specified
file ‘samplel.prj’.

6.  Load the second file for programming.

7.  Add Lock_Bit123 to the Auto function.

8.  Execute the Auto function. After the successful completion of
the programming operation, check the chip in the target system.

9.  Save the current working environment to the specified
file ‘sample2.prj’.

10. Select AMD AM27C128.
11. Load the file for programming.

12.  Edit the Auto function, adding the Blank_check, Program, and
Verify functions.

13. Execute the Auto function. After the successful completion of
the programming operation, check the chip in the target system.

14. Save the current working environment to the specified
file ‘sample3.pr;.
Create a downloading library and download.
Select Standalone from the Project menu.

Add the project files to the library. Refer to Downloading Library (Standalone) on
page 48 for more information.

Connect the programmer to the PC. You cannot use standalone function without
tirst updating the storage module (CF card) of the programmer hardware.

Select Download Library to start the downloading. To ensure the security of the
data, you may set a password to protect the data. Refer to Security and
Password Input on page 66 for more information.

Wait until the downloading is finished.

Now the programmer is able to work under a standalone mode. Refer to Execute
Production Mode to Program Chips in Batches on page 66 for more information.
Error messages:

“Please check connection of the programmer”: The programmer hardware is not
connected or an error occurs when the storage capacity is read. In this case, the
generated standalone library cannot be used.

Superpro®5000 User’s Guide 76



“Library size larger than capacity of CF card”: The added project needs a larger
storage capacity. Please increase the storage capacity (CF card capacity).

“Download library OK”: The library has been downloaded into the programmer
hardware successfully and now the programmer can be used in the standalone
mode.

“Download library error”: The library has failed to download into the
programmer hardware. Check whether the CF card is normal.

Making a Chip Blank
For the chip that can be erased electrically, execute the Erase operation.

For the chip that can be erased with ultraviolet ray, use the ultraviolet ray eraser
for 3-30 minutes.

OTP cannot be blanked once written.

Identifying the Sector
You must identify the Sector to protect some chips.
There are two ways to select the Sector:

1. Enter the address of several sectors (maximum of 8) to decide the sectors to
protect. After the Protect operation is performed, the identified sectors are
protected.
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2. If the chip has been divided into several sector groups in advance, you can
only choose these groups to be protected, as shown in the following
illustration.

Config¥ord @

Pagel i_rﬁagel

171 Groups (15--0) : [fl | Chipt Growps(31--18) :  |pooo—
. ups (41--32) : [3F00 | //)

Factory lockable Area of the SecSi (Hi_ROM) Lock
[Factor}' bit Lock Dizable V'

Customer_lockable Area of the SecSi (Hi_ROM) Lock
‘Customer bit Lock Disable V{

[ 0K ][ Cancel J

Factory Mode

This mode is designed for factory volume production. This mode only allows a
few functions (such as Auto) to prevent operation errors from destroying the chips
or to prevent wrong data from being written to the chip.

The administrator can set a password for entering the system to ensure the data
security. If the password has been set, you will need to enter the password when
exiting the system.

Select Factor Mode from the Toolbar, as illustrated below.
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File BEuffer Dewvice Option Project Help

e

Factory Node

The system displays a modified main screen, as illustrated below.

SP5000 - SUPERPRO for ¥indows

Device | | ATMEL ATB3CH! FLASH1000H'G 40Pins

| Buffer Checksum: 000FFOO0H ~ File =

SUPERPRO programmer starts -
Current time is 6/20/2008,14:02:23.

Preparing...

ATMEL ATS9C51

Algo: ATB8SCS1

Checksum: O000FFOOOH

Ready.

Success: | O " Count down: | Disabled
Failvre: | | Count Total: | O
Toot D | | Reman: ]

Reset | Reset Count Down

|| CAKCEL
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Only the following three options are active. The system does not allow any other
operations.

[l Auto: Execute the Auto programming operation.
[ Report: Generate the statistical report and display it.
[ Quit: Exit.

Factory Mode Report
Select Report from the Factory Mode Main Screen to display the statistical report.

A sample is illustrated below.

SP5000 — SUPERPRO for ¥indows

Device ATMEL ATB9CS1 FLASH1000H*S 40Pins

Buffer Checksum: D00FFODOH ~ File =

[ Print. ] | Zoomin || Zoomout |[ Close |

Report

Device Name: ATMEL ATS9CS1
Checksun: O000FFOOCH
File Name:

Start Time: Z2002-06-20 14:03:57
End Time: Z008-06-20 14:03:83

#1 #2
u}
0
[u]

[Paze 1

You can print the report on A4 size paper.
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Chapter 5 Detail Explanations on Common Problems

You can monitor the programmer operations through the Operation Information
Window and message window. This chapter helps define common problems
related to programmer actions and errors.

Dealing with Data Files

This section explains common problems involving the File Type dialog box.

Solve Invalid File Type or File Data Overflow Error

The data for programming is usually stored in the data file. Commonly used
formats are Intel Hex, Motorola and Tektronix. The files of these formats keep
data in text mode, which include data and address information. Because the offset
address is not always zero, you may incur errors when loading the file directly.

For example, the location of data in buffer (as viewed in the Edit Buffer window)
may be incorrect or you may receive an error message when loading the file, such
as “Invalid file type, or all file data overflow”.

Select one of the following options to solve this problem.
] Contfirm the file type and ensure the buffer can load all the files.

1 Find the offset address of the file. When loading the file, select the Show
Offset Address (Minimize) After Loading option to display the start address
of the file after the file is loaded.

Example: File Offset Address (min): 0x0000E0000 (Hex)

This means the offset address of the file is not 0. You must move the
data at the address to the address 0 of the buffer. To do that, load the
file again, and enter E000 as the File Address.

Refer to the Load File section on page 22 for more information on loading files.

Separate File Data for Programming

By using the File Mode selection in the File Type dialog box, you can select the
data of a file and write it to several chips of the same type. This allows you to load
the file several times according to your needs.

There are three methods for separating the file data.

1. Based on byte (8bit), divide the file into two parts by the odd and even address.
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Program the two parts into two chips respectively.

When loading the file, select Even as the File Mode to write the data in the
addresses 0,2,4,6, etc. to one chip. Select Odd as the File mode to write the data
at the address 1,3,5,7, etc. to the other chip.

Based on the byte (8-bit), divide the file into four parts by address of the first
byte, the second byte, the third byte and the fourth byte out of every four bytes.
Program the four parts to four chips respectively.

When loading the file, select the 1t byte of 4 as the File Mode to write the data
in the addresses 0, 4, 8, 12 (or C if HEX), etc. to one chip. Then select ond byte
of 4, 3" byte of 4, and finally 4'" byte of 4 to write the remaining data to the
other three chips.

Based on the word (16-bit), divide the file into two parts by address of the first
two bytes and the last two bytes out of every four bytes. Program the two parts
to two chips respectively.

When loading the file, select the 1%t 2_type of 4 as the File Mode to write

the data in the addresses 0, 1, 5, 6, etc. to one chip. Then select Z“d_byte of 4
to write the remaining data to the other chip.

Program Two or More Files to One Chip

You can load several files into the buffer and write them to the chip. The following
explanation gives an example of programming three files (Samplel, Sample2, and
Sample3) to one chip. The example assumes the following;:

[]

Write the data from the address 200 (Hex) of the file Samplel to the address 0
of the chip.

Write the data from the address 0 (Hex) of the file Sample2 to the address 3000
(Hex) of the chip.

Write the data from the address 4000 (Hex) of the file Sample3 to the address
4000 (Hex) of the chip.

Select Edit from the Buffer menu. Make sure that the Buffer clear on data load
option is not checked.

Select Load from the File menu to load the Samplel file.
"] In the Buffer Address field, enter O.
] In the File Address field, enter 200.
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3. Select Load from the File menu to load the Sample?2 file.
] In the Buffer Address field, enter 3000.
] In the File Address field, enter 0.

4. Select Load from the File menu to load the Sample3 file.
] In the Buffer Address field, enter 4000.
] In the File Address field, enter 4000.

5. Continue with programming.

If there are no changes in the file requirements or content of the three files
(Samplel, Sample2, and Sample3), you can save the data in buffer to a new file,
such as Sample4, for easy loading and programming next time.

POF Format Files

When programming ALTERA PLD devices the system saves the data in POF
format files. When loading a POF Format file, the system displays a File Type
dialog box. Select one of the following:

1. POF file: The system transforms the data into the Fuse data and checks the data
when you load it to the buffer. You may receive one of the following errors:

1 Unmatched file to this chip: This POF file does not match this chip. The
POF file is related to the device when it is compiled. The error indicates that
this POF file is not for this device. Replace the chip with a matched one.

[1 The POF file has errors.

1 Load POF file dll error (not found): An auxiliary file has errors. Contact
technical support for assistance.

2. Files of other formats are mainly the JED files. The system saves data in the
buffer in a JED file after reading the chip. You can use this format the next time
you load the file.

Adapter Selection

The standard programmer configuration supports the DIP devices with 48 or less
pins. If you want your programmer to support a device with more than 48 pins,
you will need an adapter.

There are two types of adapters: universal and specific.

1 Universal adapters are applicable for all devices of the same encapsulation and

Superpro®5000 User’s Guide 83



the same number of pins.

[l Specific adapters are applicable for certain devices only. For example, if the
number of the pins for economical programmer hardware is not enough,
specific adapters may solve the “insufficient number of the pins” problem. This
way, the programmer can also support devices with more than 48 pins

To use devices with pins between 48 and 144, you can choose either the universal
adapter or the specific adapter.

To use devices with pins more than 144, you must use the specific adapter.

Selecting the Correct Adapter

The Device Information screen displays adapter information. The following
illustration shows PLCC44 as an example.

Device Information J:\@@
A

General Information

Manufacturer : NOVATEK

Type : NT6EF632ALGAPLCCA4
Package : PLCC44

Adaptor CX2044,Ci2144

Algorithm Name : NT&E3F632

Device Information

Main Memory Block :128KExS [$00000H ~ $1FFFFH ]
Information Block : 128x8 [$2Z0000H ~ $2007FH ]
The information block can he used to store the
customer’s data.

Adaptor Information

The picture bhelow show the correct position of the device in the
socket of the adaptor (Top View)

o o o I I O o o o |

o B o v e o o 8 B B o B9 O |
L N U N

[ g g gy v

In this example, the adapter order number is CX2044 or CX2144.
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There are different order numbers for adapters because the sockets are from

different manufacturers. There may also be a minor difference in size.

Note: To ensure success, do not use self-made adapters. For best results, obtain

the adapter made by Xeltek.

Other Messages

Other error messages are explained below.

[

Please edit “Auto’ first: The Auto consequence is blank. Edit Auto and try
again.

Enter a string to search for: The Hex Edit Search dialog box is blank. Make
sure to enter a specified string or ASCII codes to search for in the Buffer Edit
dialog box.

The string for search is blank. Input it in Search dialog: Enter a string in the
Buffer Edit dialog box. Then you can use The first time search, Continue to
search, or Search Next functions.

Search pattern not found !: The system did not find a matched string or ASCII
code.

User chip is MfgID = 0089, DevilD = 0051: This display on the Operation
Information window indicates that the chip’s ID detection function detected a
different ID than specified in the manual.

ID check error. Ignore: You can ignore the detected ID error and continue the
operation.

ID check error: The operation stops because of the ID check error. If you have
good knowledge of this chip, you may ignore the ID error and continue the
operation. Exercise caution to avoid damaging the chip.

Pin check error. Ignore: The system indicates an error during the pin check.
Ignore it and continue.

Pin check error: An error occurred during the pin check, and the operation
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ceased.

Programmer not found: The programmer is not connected to the PC or it
is connected improperly. Check the connection. Refer to Chapter 2 System
Installation on page 13 for more information.

Programmer not ready: Turn off the programmer power switch and turn it on
again after a few seconds.

Programmer is running: The programmer hardware is operating. Wait until
the operation is finished.

File open error: The open file operation failed.
Out of Memory: The memory overflows.

Production mode isn't available for this chip: Since the production mode is
dependent on the pin check, the chips without pin check function are not
applicable for production mode.

Cancel production mode: Cancel the production mode.
Too long file name: The file name is too long.

User cancel: The system displays this message after you select Cancel on the
Status bar.

Can't cancel!: The Cancel operation has failed.

Not a project file: The file selected is not a project file. After the software is
updated, the software may not be able to identify a previously created file. You
will need to create the file again.

Insertion Test Errors

The following error messages may occur during the Insertion Test.

[]

No device in the socket.: The system did not detect a device in the socket.
Insert a chip.

Find non-connection or poor pin contact: The system detected poor pin
contact. Check the pin contact. If you find nothing wrong with the connection
of the noted pin(s) replace the chip with another in case the first chip is broken.

The pin number refers to DIP chip’s pin number or the adapter’s pin number.

Device inserted backwards or damaged.: Take the chip out, reverse it,
and insert it again properly. If the problem still exists, the chip may have
been damaged.
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] Device inserted upwards 3 slots!: The chip has been inserted
improperly. Refer to Dev. Information on page 35 for more information.

] An unmatched device (40 pins) inserted!: If the system detects pin contact
errors for a chip with more than 48 pins, it displays the serial number of the
DIP socket of the programmer. Check the adapter.

For any insertion test error messages, choose one of the following options.
[l Select Abort to stop the programming.
] Select Retry to run the Insertion Test again after correcting the problem.

] Select Ignore to continue the program.

Device ID Check Error

If you selected the ID Check option on the Operation Option (General) screen,
and the system checks the device ID. The system displays the following error
message if it detects an error.

SUPERPRO for Windows

! 5 Manufacturer or device ID error. Continue?,
.

[ es ] [ Mo ]

] Select Yes to ignore the error and continue programming.

1 Select No to abort the programming. When the ID is unmatched, the system
searches for matched devices and display them in the Operation Information
window.
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Appendix
XELTEK periodically publishes upgrade software on the XELTEK website. You

can download and upgrade your software from the website. Non-users may
download the software for evaluation.

Troubleshooting

If the User Manual does not answer your questions, first contact your sales agent
or the distributor. If you still need technical assistance you can call XELTEK

between Mon-Fri 7:30AM-12:00PM & 1:00PM - 4:30PM (PST). Make sure you have
your product serial number before calling.

Before contacting XELTEK, check the following to ensure you get the best service.
] Read the User Manual.
1 If you receive an error message that is not explained:
— Make sure you can repeat the circumstances that created the error.
— Write down the error message.
] Make sure you have your product serial number.

1 Check your computer configuration, including computer brand, free memory
size before starting the software, the video adapter brand, and the operating
system.

] Make sure you are at your computer when you call so the engineer can guide
you through the solution.
Contact Information

XeltekInc.

1296 Kifer Rd. Suite # 605
Sunnyvale, CA 94086
United States

General Consultation 001-408-530-8080
Order/Sales 001-408-530-8080

Email: sales@xeltek.com

Technical Support 001-408-530-8080
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Email: techsupport@xeltek.com

Fax

Website: http://www .xeltek.com

001-408-530-0096
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License Agreement

The copyright of the program and the User's Guide remain the property of
XELTEK.

You may:

1. Copy the program for back-up purposes ONLY in support of its use on a single
computer.

2. Transfer the program and license to another party if the other party agrees to
accept the terms and conditions of this agreement.

You may not:

1. Use this product on a computer system or network that allows the program to
be operated by more than one user at the same time.

2. Modify, copy, or transfer the User’s Guide or other documentation or any
copy.

3. Decompile or disassemble any program modules or encrypted devices.
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Warranty

XELTEK has a strict quality assurance system. If the software or hardware has any
defects, it can be repaired or replaced free according to the specific situation
within one-year period after the user buys the product.

The warranty is based on proper installation of the software and usage in the
specified working environment.

XELTEK is not responsible for the following cases:

] The product has been repaired, used, or changed by any organizations
or persons who are not authorized by XELTEK.

] The product has been damaged because of misuse or careless use.
] The product serial number has been changed by the user or some other person.

] The program errors caused by the physical damage of the disk.
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Looking for pricing, stock, or lifecycle information?

Click below to explore more details on WIN SOURCE:

© View BUPERPRO 500H on WIN SOURCE
) Information

Optimize Your Supply Chain with WIN SOURCE Solutions

Global Sourcing Solution
Obsolete Management
Cost Control Management
Shortage Management
Alternative Solution

Excess Inventory Management


https://www.win-source.net/products/detail/xeltek/superpro-500p.html
https://www.win-source.net/manufacturer/xeltek

